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PREFACE

“Power comes not from knowledge kept, but from knowledge shared”

-Bill Gates

The aim of this book is to introduce students and readers to the theoretical and 

practical knowledge surrounding spreadsheets. A spreadsheet is a computer 

application used to organize, analyze, and store data in tabular form. 

The book assumes basic knowledge of computer application learnt by students 

of polytechnics in first to third semester for various programs. The content of 

this eBook is based on the syllabus prepared by the Department of Polytechnic 

and Community College Education, Ministry of higher Education, Malaysia.

By using attractive illustrations and an orderly flow, it will hopefully help 

students and readers learn in an interesting way and make the learning process 

enjoyable. It also includes explanations in the text and links to videos for 

various subtopics.

We would like to thank Pn. Nariman Binti Hj. Daud, Head, Department of 

Mathematics, Science and Computer Science for their valuable suggestions and 

comments which helped in finalizing this book. 

Our special thanks to our colleagues for their continuous support and 

suggestions during the development of this book.
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Excel spreadsheet might as 
well be one of the most 

dangerous recent 
inventions 

Rolf Dobeli
_________________

picturequotes.com



Topic 2 spreadsheetspreadsheet

In Excel, a computerized

spreadsheet is called a

worksheet. The file in

which the worksheets

are stored is called a

workbook.

1. Definition of Spreadsheet 

2. Introduction to Excel

2

A spreadsheet is a 

computer application for 

organizing, analyzing, and 

storing data in tabular 

form. Spreadsheets were 

developed as a 

computerized analog to 

paper accounting 

worksheets.
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3. The Backstage

The Backstage view gives you several options for saving, 
opening a file, printing, and sharing your document.

Open

allows you to open a file 
from your local hard 
drive or from the cloud

Save & Save As

Use the "Save" & "Save 
As" menu to save the file 
to the cloud or to your 
hard drive.

Print

Manage file for printing

Share

Allows you to share the 
file via Microsoft 
OneDrive or email.

Export

allows you to export a 
file in PDF or XPS format

Publish

allows you to publish the 
file to Microsoft Power BI

New

contains options to 
create a new Excel file

Info

contains various 
information about the 
Excel file
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4. Create New Spreadsheet

4

On the Excel home screen, locate and select the 
blank workbook to open the Excel interface.
Click the Start button on the Windows taskbar. - The 
Start menu opens 

ii. Point to Programs - - The Programs menu opens 

iii. Click on Microsoft Excel - Excel opens a new 
workbook
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5. Excel Screen

Formula Bar

The formula bar allows
you to enter/edit data, a
formula, or a function
that appears in a
particular cell.

Vertical & Horizontal Bars

The scroll bars allow you to scroll
up and down or from page to
page. To do this, click and drag
the vertical or horizontal scroll
bar.

Worksheets

The Excel workbook contains one
or more worksheets. Click the tabs
to switch between them, or right-
click for more options.

Zoom Control

Click and drag the slider to
use the zoom control. The
number on the right side of
the slider indicates the
zoom percentage.

Ribbon

The Ribbon contains
several tabs, each
with several groups
of commands.

5
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File Tab
allows you to switch to the Backstage view, which
contains the most important file-related commands
and Excel options.

Home tab
Contains the essential or most commonly used
commands such as copy and paste, sort and filter,
format, and so on.

Insert Tab
is used to insert various objects into a worksheet, such
as pictures, charts, PivotTables, hyperlinks, special
symbols, equations, headers and footers.

Page 
Layout 
Tab

Provides tools to customize and manage the
appearance of the worksheet, both on screen and when
printed. These tools control theme settings, gridlines,
page margins, object alignment, and print area

Formula 
Tab

includes tools for inserting functions, defining names,
and controlling calculation options.

Data Tab contains the commands for managing worksheet data
and for connecting to external data.

Review Tab allows you to spell check, track changes, add comments
and notes, and protect worksheets and workbooks.

View Tab provides commands to switch between worksheet views,
freeze panes, view and arrange multiple windows.

Help Tab

Appears only in Excel 2019 and Office 365. this tab
provides quick access to the Help task pane and allows
you to contact Microsoft Support, send feedback,
suggest a feature, and get quick access to training
videos.

Ribbon Tabs

6
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The workbook can 
be displayed in 
three views, e.g
• Normal view
• Page Layout view
• Page Break view

6. Worksheets Views

Page 
Break 
View

Page 
Layout 

View
Normal 

View

Normal view is the default view for all worksheets in Excel. The 
following figure is an example of the normal view.

7
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In the Page Break view, you can change the position of the 
page breaks. This is useful if you print a lot of data from 

Excel.

Page Layout view shows the appearance of the printed sheet, 
and you can add headers and footers in this view.

8
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3 ways to insert New 
Sheet

● Click ‘+’ sign at the 
bottom of the sheet 

● Right-click on the 
existing sheet, which 
by default is named 
'Sheet1'.

● Click the 'Insert' icon 
on the right side of 
the ribbon to open 
a drop-down list of 
options.

7. Working with Worksheets

7.1 Insert New Worksheets

10
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● Right-click the Sheet 
tab & select. Delete.

● Or, highlight 
the sheet, then select 
Home> Delete>

Delete Sheet.

7.2 Delete a Worksheets

●Double-click the sheet
tab, and type the new
name.

● Right-click the sheet
tab, click Rename, and
enter the new name.

●Use the keyboard
shortcut Alt+H > O R,
and enter the new
name.

7.3 Rename a Worksheets

By default, Excel names
worksheets Sheet1, Sheet2,
Sheet3 and so on, but you
can easily rename them.

11
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Method 1

Copy Excel sheet by 
dragging

i. Drag-and-drop to 
move something from 
one place to another.

ii. Click the tab of the 
sheet you want to 
copy, hold down the 
Ctrl key, and drag the 
tab to the desired 
location.

7.4 Moving and copying a 
Worksheets

Method 2

Duplicate a sheet by 
right-clicking

i. Right-click the tab and 
choose Move or Copy 
from the shortcut 
menu. This opens the 
Move or Copy dialog 
box.

ii. Under In Front of 
Sheet, select where 
you want to place the 
copy.

iii. Place a check mark in 
the Create Copy box, 
and then click OK.

12
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Method 3

Copying a Tab in Excel 
via the Ribbon

To copy a sheet, go to 
the Start tab > Cells, 
click Format, and then 
click Move or Copy 
Sheet

8. Understanding Cells

Each worksheet is 
consist of thousands of 
rectangles called cells.

A cell is the intersection 
between a row and a 
column. 

Columns are identified 
by letters (A, B, C), while 
rows are identified by 
numbers (1, 2, 3).

Column

Row

Cell

13
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Note that the
column and row
headers of a cell are
highlighted when the
cell is selected.

Each cell has its own name or address - based on its column and row. For 
example, column C and row 5, so the name or address of the cell is C5. The 

name or address of the cell is also displayed in the Name field

Cell 
address 

appears in 
Name Box

Multiple cells can also be selected at the same time (this is called a 
cell range). For example, a cell range that includes cells A1, A2, A3, 

A4, and A5 is written as A1:A5.

Cell range A1:B8Cell range A1:A8

14
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2.8.1 Mouse Pointer

There are several different types of mouse pointers

Mouse 
Pointer

Image Description

General Select

Selecting a range of cells by
clicking and dragging the mouse
over the cells.

Fill/Copy
Copying cell contents or using
the auto-fill feature.

Move Cell (or 
range of cells)

Moving contents of a cell or
range of cells. Click and drag to
move cell contents.

Column/Row 
Resize

Make columns or rows wider or
narrower. Click and drag to resize
manually or double-click to resize
to the widest entry.

Column/Row 
Select

Select a column or row. Click
once to select the column or row.
Click and drag across the
headings to select multiple rows
or columns.

15
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2.8.1 Understanding Cell

Cells can contain various types of content, 
including text, formatting formulas, and functions.

Text

Cells can contain text, such as letters, 
numbers, and dates.

Formulas and functions

Cells can contain formulas and functions
that calculate cell values.

Formatting attributes

Cells can contain formatting attributes 
that change the appearance of letters, 
numbers, and dates. Percentages, for 
example, can be displayed as 0.19 or 19%.

16



KEEP CALM
i have 

a spreadsheet
for that

Anonymous
_________________

goodreads.com
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2.8.2 Resizing and merge cell 

Each row and column of a new workbook is set to
the same height and width by default.

AutoFit columns 
and rows with a 

double-click

17
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2.8.3 Autofill

AutoFill is the 
property in Excel 
that automatically 
fills the next value 
into the next cell. 

To AutoFill, you need 
to move the cursor 
horizontally or 
vertically until you 
release the key

There are some 
AutoFill properties 
that are already 
defined in Excel, 
such as month, day, 
number, etc. But we 
can also create our 
own AutoFill 
properties.

Fill Series

Copy Cells

18
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2.8.4 Sorting

Sorting is a common task that lets you change or adjust 
the order of your spreadsheet data

Sort 

Click Sort and you have
the option to sort from A
to Z or vice versa.

Here is an example of
data sorted from A to Z.

19
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• Select the cell(s) you want to 
copy
On the Home tab, click the Copy 
command, or press Ctrl+C on 
your keyboard.

• Select the cell(s) into which you 
want to paste the content.

• Click the Paste command on the 
Home tab, or press Ctrl+V on 
your keyboard. 

• The content is pasted into the 
selected cells.

• Select the cell or range you want 
to cut.

• Click the Cut button on the 
Home tab. (Or Press Ctrl + X)

• Click the cell where you want 
to paste your data.

• Click the Paste button. (Or Press 
Ctrl + V)

COPY AND 
PASTE

CUT AND 
PASTE

Copy Cells
Paste 

Destination

2.8.5 Copying and moving data

20
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● Select 
any cell within 
the row or column, 
then go to 
Home> Insert> Ins
ert Sheet Rows/Col
umns

● or Delete Sheet
Rows/Columns.

● Alternatively, 
right-click 
the row number or 
the column 

2.8.6 Insert or delete a row and column

21
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Error Example

##### 
If your cell contains this error 
code, the column isn't wide 
enough to display the value. 

#NAME?

The error  #NAME? occurs 
when Excel does not recognize 
text in a formula.

#VALUE!

Excel displays the error 
#VALUE!  when a formula has 
the wrong type of argument.  

#DIV/0! 

Excel displays the error  
#DIV/0!  when a formula tries 
to divide a number by 0 or an 
empty cell.  

#REF!

Excel displays the error # REF! 
when a formula references a 
cell that is not valid.
Cell C1 refers to cell A1 and cell 
B1.

2.8.7 Common Error in Excel

22
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Rolf Dobeli
_________________

picturequotes.com

….correctly applying a 
spreadsheet formula 
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2.9 Formulas and Functions

formula is an expression used to calculate the value 
of a cell. Functions are predefined formulas and 
already available in Excel. All formulas must start 

with an equal sign (=)

=SUM(A1:A20)

Equal 
Sign

Function 
Name Argument

Formula 
Result

Formula Bar

2.9.1 Basic Function

MATHEMATICS 
OPERATIONS

SYMBOL

ADD +

SUBTRACT -

MULTIPLY *

DIVIDE /

Name Function

Sum Total

Average Average of data

Max Largest value

Min Smallest value

Count The number of entries

Name Function

24
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Example
TABLE A

Refer to the Table A, calculation use function:

FUNCTION STATEMENT ANSWER

TOTAL (SUM) =SUM(C3:C7) 345

Highest Mark =MAX(C3:C7) 90

Lowest Mark =MIN(C3:C7) 50

Average Mark =AVERAGE(C3:C7) 69

Number or student =COUNT(C3:C7) 5

MATHEMATICS 
OPERATIONS

EXAMPLE ANSWER

ADD =C3+C4 140

SUBTRACT =C3-C5 -30

MULTIPLY =C3*C6 3500

DIVIDE =C4/C7 1.64

25
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2.10 Transpose Table

Step to transposing the table

Transpose - Change row and column of the data

1. First select the table
2. Click with the right mouse 

button and copy
3. Go to another cell or 

worksheet
4. Select Paste Special
5. Click on the Transpose 

check box and then on OK

26
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2.11 LOOKUP Function

The function LOOKUP is assigned to the category Excel Lookup 
and Reference Functions. 

The function performs a coarse search in either a single-line or 
single-column range and returns the corresponding value from 

another single-line or single-column range.

Records in 
row

2.11.1 VLOOKUP Function

• VLOOKUP is an Excel function for locating and 
retrieving large data in a vertically organized table.

• VLOOKUP supports approximate and exact matches, 
as well as wildcards (* ?) for partial matches. 

• Data must be in one row
• VLOOKUP requires a lookup table with lookup values 

in the left-most column.

27
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1 2 3 4 5

Formula for VLOOKUP

=VLOOKUP(value, table, column, FALSE) (for exact match)

Lookup 
formula

Lookup 
value

Lookup 
result

28

VLOOKUP 
VIDEO

VLOOKUP has two modes for matching: exact and 
approximate, controlled by the 4th argument 

“range_lookup". 
Set range_lookup to FALSE to force exact matching, and 

TRUE for approximate matching.

https://support.microsoft.com/en-us/office/vlookup-function-0bbc8083-26fe-4963-8ab8-93a18ad188a1
https://www.youtube.com/watch?v=ODZfwD39gGE
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2.11.2 HLOOKUP Function

HLOOKUP is an Excel function for looking up and retrieving 
data from a specific row in a table. 

The "H" in HLOOKUP stands for "horizontal", meaning that 
the lookup values appear in the first row of the table and 
move horizontally to the right.

HLOOKUP supports approximate and exact matches, as 
well as wildcards (* ?) for finding partial matches.

1

2

3

4

Records in column

Lookup 
formula

Lookup 
value

Lookup 
result

Formula for VLOOKUP

=HLOOKUP(value, table, row, FALSE) (for exact match)

29

VLOOKUP 
VIDEO

https://support.microsoft.com/en-us/office/vlookup-function-0bbc8083-26fe-4963-8ab8-93a18ad188a1
https://www.youtube.com/watch?v=eGNVhJTWoE0


Yes. I appreciate the 
helpful and long 

spreadsheet with all the 
many places you can't go.

Shelly Laurenston, The 
Mane Event

_________________
quoteslyfe.com
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2.12 Chart or Graph

• A chart is a tool you can use in Excel to graphically represent 

your data. 

• Charts allow you to see the meaning behind the numbers and 

make comparisons and trends much easier. Excel has several 

types of charts from which you can choose the one that best 

fits your data.

i. Select the cells you want to plot on a graph, including column 

titles and row labels. These cells will be the source data for the 

chart. In our example, we will select cells A1:F6.

2.12.1 Creating a Chart or Graph

30
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ii. On the Insert tab, click the chart command you want. We 

can Select recommended charts or another chart type.

Recommended 

Charts

iii. Choose the desired chart 
type from the drop-down menu

31

CLICK Here - Video Creating Chart

https://www.youtube.com/watch?v=5YJldUEgscQ
https://www.youtube.com/watch?v=5YJldUEgscQ
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2.13 Print a Worksheet

To print a worksheet in Excel, follow these steps.
1. on the File tab, click Print. 2. to preview the other pages.
2. to preview the other pages that will print, click Next Page or 
Previous Page at the bottom of the window.

Orientation

can choose portrait 

or landscape 

orientation.

Margins

The smaller the 
margins, the 

more space you 
have for your 

data

Preview Pane

Aa preview of 
how your 

worksheets will 
look when 
printed.Paper Size

Choose the 
paper size

Page 
Selection

Click the arrows 
to view a 

different page 
in the preview 

window.

Show Margins / 

Zoom to Page

The Zoom to Page 
button - zooms in 

and out of the 
preview pane. The 

Show Margins 
button - displays the 

margins in the 
preview pane..

32
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Follow the instructions:

1. Open a blank workbook

2. Write the following entries into the specified cells:

3. Merge the cells from A2 to G2. Apply the following changes to the title 

line:

• Change the horizontal and vertical text alignment to centered.

• Change the row height of row 2 as 30.

• Change the font, font size, font style and font color as Century 

Gothic, 18,bold, purple.

4. Select the cells from B3 to G3 using the range selector. Then press the 

Ctrl key on the keyboard and select the cells from A4 to A6. (You can select 

multiple cells in different parts of the worksheet this way) Now change the 

font, font size, and font style of the selected cells to Times New Roman, 12, 

bold italic. 

5.Place a border around the data entries and choose a suitable color.

C2 : Annual Fruit Sales

B3 : 2000 A4 : Orange     F3 : Total

C3 : 2001 A5 : Grape       G3 : Average

D3 : 2002 A6 : Banana

E3 : 2003

B4 : 1050 B5 : 2300 B6 : 550

C4 : 1250 C5 : 2500 C6 : 300

D4 : 850 D5 : 1250 D6 : 650

E4 : 1300 E5 : 1450 E6 : 250

Exercise 1

https://drive.google.com/file/d/1NpYVyZO6DvswlBuUxP9VFuB529uWbgjj/view?usp=sharing
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Exercise 2

Follow the instructions:

1. Select the range A1:G1.

• Put the title in bold and increase the font size to 16.

• Click the Merge and Centre tool on Excel's Formatting toolbar.

2.   Merge the multiple words in the table as well. 3.

3.   Place a border around the data entries and choose a suitable colour. 

A B C D

1 SALES
2 January RM5,400.00 

3 February RM3,152.00 

4 March RM6,582.00 

5

6 Sales

7 January 5,400.00 

8 February 3,152.00 

9 March 6,582.00 

Exercise 3

1. Use the Format Painter button on Excel's Standard toolbar to quickly 

format the second table the way the first table was formatted.

A B C D E F G

1 MY TIME TABLE

2

3 DAY / TIME 8 - 9 A.M 9 - 10 A.M 10 - 11A.M 11-12 A.M 11-12 A.M 11-12 A.M

4 MONDAY BM BM REST MATHS AGM PJ

5 TUESDAY BI MATHS REST SC SC MZK

6 WEDNESDAY BI SC REST BM BM AGM

7 THURSDAY MATHS MATHS REST BI BI PJ

8 FRIDAY SC SC REST BM BM AGM

https://drive.google.com/file/d/1HPyR9FcMew7QV-etN2s4PeyuiZtBWQpq/view?usp=sharing
https://drive.google.com/file/d/1cvGSIxSTMS4juu9dq-jTllt_BRxLBTfh/view?usp=sharing
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Apply the formatting as follow.

100 Currency

100 Percentage

100000 Thousands comma 
separator

100.0 Increase decimals

Exercise 4

D E F H

4 5 March Qtr 1 MONDAY

5 10 April Qtr 2

1. Insert the data below follow to the columns and rows shows.
2. Select range D4:D5 
3. Position the pointer on the "fill box", the small black square in the lower right 
corner of the selected range.

4. Drag the fill box down so Excel  continues the sequence of numbers.
Do the same for E4:E5 , F4:F5 and H4 .

Exercise 5

https://drive.google.com/file/d/1G6kE9HKI79QmEExG9eCNuOFVhENuaBaD/view?usp=sharing
https://drive.google.com/file/d/11FEUz2YjiNZk2eD8tcxVBRHsZokapt9E/view?usp=sharing
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By using MAX, MIN AND SUM function, find the maximum, minimum and sum 
value within a range of cells.

Building Height (m)

Four Seasons Place KL 343

Vortex Tower 260

Petronas Twin Tower 452

Telekom Tower 310

Maybank Tower 244

34

Exercise 1

Exercise 2

C D

5 Data in Rows

6 January 55 35

7 February 23 29

8 March 12 18

1. paste the data below and follow the columns and rows shown 2. select the 
range C6:D8.
3. from the Excel menus, choose Edit, Copy.
4. click on cell B10
5. in the Excel menus, choose Edit, Paste Special to open the Paste Special 
dialog box. 6.
6. click the Transpose option at the bottom of the dialog, and then click OK.

https://drive.google.com/file/d/1tTwl2UNZQkJlJE-9mG1yHqnkWqWBLUdH/view?usp=sharing
https://drive.google.com/file/d/128PV2Ahg_IaaL3fQFc0ZUWhXebM197At/view?usp=sharing
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3. Arrange the following people from the oldest to the youngest 
and calculate the average age. 

Name Age

Naurah 24

Nuha 17

Naufal 32

Umar 16

Aafiyah 36

Irsyad 21

34

Exercise 3

https://drive.google.com/file/d/1lA3PIRRkgHyqgIJ22xOJkcTS5WPvZy79/view?usp=sharing
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b) Merge and Center the title ‘EXPENSE PLAN’ in the range A1:E1

c) Bold the range A3: E3, A4:A13 and B14:B16

d) By using suitable formula, find the value of Monthly Spend and Percent 

Change.

e) AutoSum the Totals  for cells B13 to E13.

f) Use the Average function to find the value in cell C14 and D14

g) Use the Min function to find the value in cell C15 and D15 

h) Use the Max function to find the value in cell C16 and D16     

i) Format the number of price cells as a currency.

j) Format the column Percent Change as a percentage.

k) Create a pie chart of the Monthly Spend.

Open the new worksheet, and then

a) Enter the following data into cell address

35

Exercise 4

https://drive.google.com/file/d/14MkJxX4kPGQmGKHUDCv5UC94HaeCFrdj/view?usp=sharing
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b) Merge and Center A1 to the range A1:F1
c) Merge and Center A2 to the range A2:F2
d) Bold and Center A3:F3
e) Bold A4:A10
f) Calculate the sub-total in cell D4
g) Use the Fill Handle to copy the formula in cell D4 to the range D5:D10
h) Calculate the tax amount in cell E4
i) Use the Fill Handle to copy the formula in cell E4 to the range E5:E10
j) Use the Fill Handle to copy the formula in cell F4 to the range F5:F10
k) Apply the Light Blue Data Bar Conditional Formatting to the range 

F4:F10
l) Apply the Total Style to the range A12:F12
m) AutoSum the range F4:F10 in cell F12
n) Use the Max function to calculate the Max value of F4:F10 in Cell F13
o) Use the Min function to calculate the Min value of F4:F10 in Cell F14

Follow the instruction below.

a) Create a new worksheet and enter the following data. 

36

Exercise 5

https://drive.google.com/file/d/1CJeHZdMzgtMPIlbjb358cfFKsYgijS8L/view?usp=sharing
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6. Follow the instruction below.

a) Open a new spreadsheet file.

b) Create a table as given below.

c) With suitable formula, fill the color parts. (Refer the formula given)

d) Insert the institution logo.

e) Create a bar chart of the total marks of all students.

37

Exercise 6

https://drive.google.com/file/d/1_Ci1EJfgPVzat5MN4WHYerxQ0Bu4iXRM/view?usp=sharing
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b) Merge and Center the title “Market Shares of Major Phones Providers in the 
United States” in the range A1:G1 

c) Change the title font to Cambria 14 pt. Bold 
d) Merge and Center the sub-title “Cellular Phones Sales During Five Years” in the  

range A2: G2
e) Change the sub-title font to Time New Roman, Bold
f) Bold the range A3:A13 and B3:G3 
g) Apply Total style to the range A10:F10 
h) Type =B4+B5+B6+B7+B8 in cell B10, then press enter 
i) Use the AutoSum function to calculate the total in cell C10 for the range C4:C8
j) Use the Fill Handle to copy the function in cell C10 to the range D10:F10
k) AutoSum the range B4:F4 in cell G4 
l) Use the Fill Handle to copy the function in cell G4 to the range G5:G8
m) AutoFit the contents of each column (Do not display #######) 
n) Add the $ sign from the range B4:F8 and set the Decimal Places to 0 
o) Use the Max function to display the highest value of the range B4:B8 in cell 

B11
p) Use the Min function to display the lowest value of the range B4:B8 in cell B12
q) Calculate the average of the range B4:B8 in cell B13
r) Select the range B11:B13 and use the Fill Handle to copy the functions in these 

cells to the  range C11:G13 
s) Delete row 9 

Follow the instruction below.

a) Create a new worksheet and enter the following data. 
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Exercise 7

https://drive.google.com/file/d/1--L2P_beQyjqz6NuHCH6ntni_okvyBH1/view?usp=sharing
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PART 3
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Follow the instructions:

1. Download the Vlookup Exercise table here:

Playground Safety Checks

Site Code Site Location Swings Slides Rocker
Climbing 

Frame

Overall 

Result

A001 Lake Garden 6 8 7 9 Fail

A002 Bukit Jalil Park 8 9 8 9 Pass

A003 Sunway Playground 5 7 7 8 Fail

A004 Titiwangsa Lake 9 8 8 9 Pass

A005 Tasik Perdana Park 7 8 7 8 Fail

A006 Putrajaya Park 8 6 8 8 Fail

A007 Taman Merdeka 7 8 9 8 Pass

Exercise 1

2. Find the data by insert the formula of VLOOKUP. (Change the

code to see another result.

Site Code: <--- Change Code here

Location:

Swings:

Slides:

Rocker:

C/Frame:

Overall:

https://docs.google.com/spreadsheets/d/1Zagi0Fuq8k26oEjDHJ9KATt31vltwCCD/edit?usp=sharing&ouid=108927733294097161461&rtpof=true&sd=true
https://drive.google.com/file/d/1--L2P_beQyjqz6NuHCH6ntni_okvyBH1/view?usp=sharing
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